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I. Introduction

I-1. Purpose

This document provides specific technical information for users of the CLEA software mbdularge-Scale Struc-

ture of the Universe It includes discussions of hardware and operating system requirements (Section Il); software
installation and operation (Section Il1); files associated with the exercise (Section 1V); user options and file formats for
possible user modifications (Section V); and astronomical data, models and algorithms employed in the exercise (Section
VI). An ancillary plotting program used in the exercise is described in the Appendix. The material in this guide is
intended for use by the instructor and by other personnel involved in installing and configuring the exercise software and
PC hardware. It is not intended for distribution to the students. (The word “user” when it appears herein should be
interpreted agstructor, and not student.)

Readers of this document are assumed to have availaliketiezal Users’ Guide to CLEA Windows Softwarewhich
contains technical information that applies to all CLEA Windows software. Much information contained therein is not
repeated here. In cases of conflicting information, this guide should be considered definitive for the LSS software.

I-2. Acknowledgments

Development of CLEA exercises and materials, including this guide, is supported in part by National Science Foundation
Grants USE 9155927 and USE 9354514, and by Gettysburg College.

ll. System Requirements

This software runs on IBM and compatible PCs under Microsoft Windows 3.0/3.1 or Windows 95 (as a 16-bit Windows
application), and under OS/2 (using the WIN-OS2 facility). A minimum of 4 MBytes of RAkaaglyrecommended,

8 MByte is better. Due to the large amount of ancillary data, approximately 7 MBytes of hard disk storage are required
for a full installation. This requirement is reduced by 2 MByte if the spectrum files (*.SP - see Section IV-5) are already
present, or are deemed unnecessary by the instructor. Additional savings can be achieved by judiciously deleting
unneeded files after installation - see Section IV for details. A color VGA monitor is required. For additional informa-

tion on systems requirements and recommendations, including a discussion of color modes and video cards/accelerators,
see theSeneral Users’ Guide to CLEA Windows Software

II-1. Recommendations

This is a lengthy exercise that is primarily intended for use as a group project. The amount of time required to gather the
data will increase significantly on older, slow machines, which will not only exhibit sluggish slewing with long pauses for
data loading/bitmap generation (see Section VI-3), but will also require substantially more time for the integration of
spectra. We strongly recommend that this exercise be performed on 486 or Pentium machines, with video accelerators if
possible. If slower machines must be used, follow the recommendations given in Section VI-3.

At certain points in this exercise, especially when measuring and recording the spectral line positions, it is advantageous
to have sufficient room on the screen to reposition display windows and dialog boxes so that all pertinent items are
accessible. To facilitate this, we recommend that, if possible, this exercise be run in a 800x600 or 1024x768 pixel
display mode. If your video card and monitor support either of these modes, you can switch to it by following the
instructions in th&eneral Users’ Guide to CLEA Windows Softwarefor changing the video driver.

lll. Installation and Operation

Files comprising this exercise (Section 1V) are compacted into four distribution files, CLEA_LSS.ZIP, LSSDAT.ZIP,
LSSBMPS.ZIP, and LSSPLOT.ZIP. The PKUNZIP program (also included on the distribution diskette) must be used to
extract the contents afl four and place the expanded files together in a single directory, such as C:\LSS_LAB.
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Details of the unpacking process and other information on installing and running CLEA software under Windows are
given in theGeneral Users’ Guide to CLEA Windows Software

Two files, VBRUN300.DLL and CMDIALOG.VBX, require special attention. These files are included in the distribu-

tion file LSSPLOT.ZIP (Section 1V-4), and must be present in the Windows system directory in order for the Plot
program (see Appendix) to run successfully. After unpacking LSSPLOT.ZIP, check the Windows system directory
(probably C:A\WINDOWS\SYSTEM) for the presence of files named VBRUN300.DLL and CMDIALOG.VBX. (You

can use either the DOS DIR command or the Windows File Manager to do this.) If these files are not present in
C:\WINDOWS\SYSTEM, or are present but carry older dates than the versions supplied in LSSPLOT.ZIP, then copy (or
move) VBRUN300.DLL and CMDIALOG.VBX from your working directory to C\WINDOWS\SYSTEM. (These
instructions apply to Windows 95 as well as Windows 3.0/3.1.)

IV. Files Included With Exercise

This exercise requires a large number of files for its operation. Most of these are compressed into the distribution files
CLEA_LSS.ZIP, LSSDAT.ZIP, LSSBMPS.ZIP and LSSPLOT.ZIP, and should be present in your working directory after
unpacking with PKUNZIP. These files are described in Sections IV-1 through IV-4 below. Section IV-5 describes how
spectrum index and template files distributed with the CLEA exeftiseClassification of Stellar Spectrean be

utilized with this exercise to provide authentic spectra of the stars that appear in the galaxy fields. Section V-6 identifies
additional files that are not included in the distribution, but will appear in the working directory during/after execution of
the exercise software. The file descriptions include references to related discussions elsewhere in this document.

IV-1. Files in CLEA_LSS.ZIP

The following files are compressed into the distribution file CLEA_LSS.ZIP.
README.LSS - Notes on the current version, including any incompatibilities with previous versions, old files
that should be deleted, etc. (Not included with Version 0.60.)

UPDATE.LSS - A list of updates (by version) since version 0.60 (the first version to be widely circulated). (Not
included with Version 0.60.)

USRGUIDE.LSS- This document, in text form.
CLEA_LSS.EXE - The executable code for the exercise.

GLSPLNS.LST - Rest wavelengths and identifications of absorption lines in galaxy spectra. (See Section V-
2.2.3)

CLEAHELP.HLP - Text for “Help”..“On Help”.

LSSHLP.LST - Help topic index list.

LSSLAB.HLP - Help text by topic.

REMINDER.LSS - Text to display when student exits the program.

IV-2. Files in LSSDAT.ZIP

The following files are compressed into the distribution file LSSDAT.ZIP.
LSSFILES.DAT - A list of available sky fields. (See Section V-2.1.1)

GLIMAGES.DAT - A list of the galaxy image bitmap files, including dimensions and image centers. (See Section
V-2.2.1))
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F120829.DAT

F122429.DAT

F124029.DAT

F125629.DAT

F131229.DAT

F132829.DAT

F134429.DAT

F140029.DAT

F141629.DAT

F143229.DAT

F144829.DAT

F150429.DAT

F152029.DAT

F153629.DAT

F155229.DAT

F160829.DAT - Data for the sky fields (see Sections V-2.1.2, VI-1). The file names reflect the approximate field
centers (format: HHMMDD, where HH is hours Right Ascension, MM is minutes Right Ascension, and DD is
degrees Declination).

IV-3. Files in LSSBMPS.ZIP

The following bitmap files (containing images for displays) are compressed into the distribution file LSSBMPS.ZIP.
CLEALOGO.BMP - 256-color bitmap data for the CLEA Logo screen.
CLEALG16.BMP - 16-color bitmap data for the CLEA Logo screen.
LSSLAB.BMP - 256-color bitmap data for the Title screen.
LSSL16.BMP - A 16-color version of the Title screen.
GLEnnn.BMP - Bitmap images (small and large-scale) of elliptical galaxies (Section V-2.2.2).
GLSnnn.BMP - Bitmap images (small and large-scale) of spiral galaxies (Section V-2.2.2).

IV-4. Files in LSSPLOT.ZIP

The following are compressed into the distribution file LSSPLOT.ZIP.
PLOT.EXE - The executable code for the plotting program. (See Appendix.)

VBRUN3O00.DLL - This file, or a more recent version, must be present in the Windows system directory (probably
C:\WINDOWS\SYSTEM) in order to run PLOT.EXE (see Section IlI).

CMDIALOG.VBX - This file, or a more recent version, must be present in the Windows system directory (probably
C:\WINDOWS\SYSTEM) in order to run PLOT.EXE (see Section IlI).

IV-5. Stellar Spectra Files

The Jacoby stellar spectra provided with the CLEA exefidigeClassification of Stellar Spectnaay be utilized with

this exercise. If the files compacted into the distribution file JISPECTRA.ZIP (files J001.SP through J161.SP) and the
spectrum index file (JSPEC.SP)I are made accessible, appropriate stellar spectra can be “taken” with the exercise
spectrometer when a star rather than a galaxy is positioned in the slit.
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This feature is not required for the Large-Scale Structure exercise and is provided purely for authenticity. (If the files are
not available the spectrometer will record only sky noise when the slit is positioned on a star image.) To make use of this
feature you must provide an entry in Bygectra Index Listfile name option, as described in Section V-1.2. The Jacoby
spectral material and other related matters, including the CLEA spectral type code and the spectrum index file, are
described in detail in th®oftware Users’ Guidefor the CLEA exercis&he Classification of Stellar Spectra

IV-6. Files Generated During Execution

The following files are generated during execution of this exercise, and will appear in the working directory.
(CLEALOG.LOG and LSS_OPTS.INI are automatically created. Files with extension .CSV are created on option, as
noted. The results file, which stores the plotting data, may be shared with other PCs in a group exercise.)

CLEALOG.LOG - A record that includes the program name (CLEA_LSS), the date and time, and the names and
table number from the Login dialog is appended to this file whenever the exercise is started, and when it is
terminated. This file is in text format and can be read and/or printed at any time. Since this file can grow
without limit it should be deleted from time to time (via DOS or the Windows File Manager). A new file will
then be started at the next login. This file can optionally be given a different name (see Section V-1.2).

Note A logout record will be written to this file only if the students exit correctly from the program (Siddect
>Exit from the main menu). They should be instructed to do this, rather than simply abandoning the computer or
turning it off.

LSS _OPTS.INI - This file holds current settings for file names and options. LSS_OPTS.INI can be deleted if
desired, it will then be re-created from internal defaults when the program is run. If the options are updated (see
Section V-1), the previous version is saved as LSS_OPTS.BAK.

* CSV - Files with the extension .CSV are created when exercise data is saved via s¢ldetkidata-> Save..
from the main menu. These files are in the format described in Section V-3.1, which contains additional
information concerning their use in spreadsheet programs and as a data backup/restore facility.

Results File- New results data (positions and calculated redshift velocities for plotting) are appended to the results
file via selectiong-ile->Data>-Save Results for Plot. from the main menu. This file is identified in the
options field ashared Results Filg(Section V-1.2), and may reside on a network drive so that the contribu-
tions of all members of a group may be combined. The format of this file and other information concerning its
use are given in Section V-3.3.

Note: Files *.CSV should be periodically deleted from the working directory when they are no longer needed. This
can be done under DOS or via the Windows File Manager. The results file(s) will also require periodic deletion or
clean-up

V. User Option and Data

This software has been designed to provide the user with a great deal of flexibility in configuring the facility for specific
needs. Users may replace or add galaxy images, add or modify star-galaxy fields, modify the Help facility, modify
telescope and star image parameters, attach a spreadsheet program, and select from a list of optional features. Details of
the facilities providing this adaptability are given in Sections V-1 through V-4 below.

V-1. Parameters and Selectable Options

In all CLEA software, modification of control parameters and options is accomplished through an options dialog that is
accessed through the login dialog, via a password. Details of this feature, including the password access, are provided in
theGeneral Users’ Guide to CLEA Windows Software
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Due to the number of modifiable features associated with this exercise, the options facility comprises three dialog
windows, as detailed in the Sections that follow (V-1.1 through V-1.3).

V-1.1. Switches and Parameters

The following switches and parameters appear on the window titled “Startup Parameters/Options”, which appears as the
main dialog when the options facility is accessed.

UT-Local Time: Enter the value (in integer hours) of Universal Time minus local (zone) time for the presumed
location of theobservatoryfor this exercise. This number is used to convert the time obtained from the system
clock on the individual PC to Universal Time. The table below gives the standard time values for North
American time zones. (For daylight time, subtract one from the table value.) The default is 5 hours (Eastern
Standard Time).

ZONE UT-ST (Hrs)
Atlantic 4
Eastern 5
Central 6
Mountain 7
Pacific 8
Alaska 9
Hawaii 10

Base Magnitude:The base magnitude for spectrum integration and other computations (see Section VI-4). The
default value is 9.00.

Sky Magnitude: The sky brightness for spectrum integration and other computations, expressed as a magnitude (see
Section VI-4). The default value is 19.00.

Base Photon CountThe photon count associated with the base magnitude (see Section VI-4). The default value is
50.

Timer Wait: The time (in milliseconds) between successive counting steps during spectrum integration. The default
value of 1 means that the speed of integration is normally limited by the speed (CPU and video display) of the
computer. This parameter is provided so that in the future, extremely fast processors may be slowed down to
realistic rates of spectrum integration.

Wavelength Range:The wavelength range in Angstroms (A) for the spectral displays. For best results in labeling
and appearance these values should be multiples of 100 A. If the available data (Section V-2.1.3) does not
cover the range specified, the spectra will appear truncated. The default range is 3900 to 4500 A, which is the
range of the stellar spectra supplied with the exercise (see Section IV-5).

Use Small Help FontWhen this switch is set, a small type face is used for the Help windows to improve their
appearance and use less space on the screen. This font may be too small to be read easily in some screen mode:
The default i€On.

Restrict Telescope AccesdVhen this switch is set, the student must apply for access to the larger (1 and 4 meter)
telescopes, and receives a limited number of uses if access is granted (see Section V-1.3 for associated param-
eters). The default ©n.
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Show Magnitudes:When this switch is set, the apparent magnitude (V) of the object is displayed in the Reticon
Spectrometer window during spectrum integration. The defaDh.is

Show Object ID: When this switch is set, the object name is displayed in the Reticon Spectrometer window during
spectrum integration. The defaulOs.

Login Required: This switch is provided for those who may wish to avoid the login process when using this
software as a demonstration. When this switch is offRuneselection on the main menu, as welLagin, is
enabled when the program startsRiim is then selected befot@gin, the program proceeds as if the login
process had actually occurred. (In this case the 1st login name i©setoostration, the file name base
becomeDEMO, and thd_ogin menu selection is disabled.) The defau®is

Compute Velocities: When this switch is set, values in themputed Velocity column on the Record Measure-
ments dialog are automatically calculated by the software (using the entered line measurement values) when the
Verify/Average button is pressed. (Normally, the student is required to compute and enter the velocity values).
The default iOff.

Table Number: This field allows the instructor to preset the table number for each machine in the lab. This number
then appears as the default on the Login dialog. The table number has a maximum length of 4 characters, but
need not be numeric.

Password: This is the password for access to the Options dialog. Allowable passwords have a maximum length of
16 characters, and are case sensitive. The default pass\@hHAs

V-1.2. File Name Options

The following file and path name parameters appear on the windowRitleNameOptions To access this dialog press
the button labelefiles... on theStartup Parameters/Optionswindow. See th&eneral Users’ Guide to CLEA
Windows Softwarefor discussions of Windows bitmap (.BMP) files, including logo and title screens and color issues.
256-Color Logo: A 256-color bitmap for the CLEA logo screen. The default is “CLEALOGO.BMP”.
16-Color Logo: A 16-color bitmap for the CLEA logo screen. The default is “CLEALG16.BMP”.
256-Color Title: A 256-color bitmap for the exercise title screen. The default is “LSSLAB.BMP”,
16-Color Title: A 16-color bitmap for the exercise title screen. The default is “LSSL16.BMP”.

Sky Fields List: A list of sky fields for the exercise (see Section V-2.1.1). The default is “LSSFILES.DAT".

Galaxy Images List: A list of galaxy image bitmap files, including dimensions and image centers (see Section V-
2.2.1). The default is “GLIMAGES.DAT".

Spectral Lines List: A list of spectral lines in the galaxy spectra that are used to measure the radial velocity (see
Section V-2.2.3). The file entries give line IDs and rest wavelengths. The default is “GLSPLNS.LST".

Spectra Index List;_ To enable students using this exercise to record spectra of ordinary stars, enter the fully
qualified file name of the spectra index list in this field (for exanf@dSPEC _LAB\JSPEC.SPI"). The
spectra files (*.SP) must also reside in the same directory (in thiSCaSPEC_LAB” ). Note that these files
are provided with the CLEA exerci3ée Classification of Stellar Spectrand not with this one - see Section
IV-5 for details. The default is “” (no entry).

Main Help List: An index list of Help topics for the Main Window (see Section V-4.1). The default is
“LSSHLP.LST".
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User Help File: Site-specific Help information available under “Help”..."User” (see Section V-4.1). The default is
“” (no entry).

Reminder File: Text to be displayed when the students want to terminate the exercise (see Section V-4.1). The
default is “REMINDER.LSS".

Spreadsheet Program FileThe full file name (including path) of a spreadsheet program to be accessed during the
exercise for data manipulation and analysis (see Section V-3 for details). The file must be of type .EXE or .PIF,
and must be accessible from the student’s computer in the drive and file specified (example:
C:\EXCEL\EXCEL.EXE). This parameter is completely optional. There is no default.

Plot Program File: The name of the program to be called whie->Wedge Plotis selected from the main menu.
If the program does not reside in the working directory a full path name must be supplied. The default is
“PLOT.EXE".

Shared Results FileThe name of the file that holds results (positions and radial velocities) for the plotting
program (see above). The student seleiés>Data->Save Results for Plot. from the main menu to append
data to this file. For a group project this file would normally reside on a network drive and be shared by the
individual laboratory stations. (In this case, the file name must include full path information.) See Section V-
3.3 for additional information about this file and its use in a network environment. The default is “PLOT.TXT”
(a private (i.e., not shared) file in the user’s working directory).

Log File: A file (text format) where log information is written during login and at termination of the exercise (see
Section IV-3). The defaultis “CLEALOG.LOG".

V-1.3. Telescope Parameters

This exercise provides the students access to three telescopes, a 0.4 meter (16 inch) default telescope that is always
available to them, and 1 meter and 4 meter (40 and 160 inch) instruments whose use may (optionally) be restricted. If the
Restrict Telescope Accesswitch is set (Section V-1.1), the students must apply for time on the larger instruments, and

are given a limited number of uses if time is awarded. The rate of integration of spectra is accurately scaled to the size of
the telescope in use. The following parameters, which appear on the windoWelitlszbpe Parameterallow the user

to modify various aspects of this facility. To access this dialog, press the button |Scelhed... on the Startup
Parameters/Optionswindow.

Name: The name or identification of the telescope. (38 characters)

Site: The site of the telescope. (35 characters)

Availability: The fraction of applications for telescope time that will be approved. (0.0 to 1.0) To make a tele-
scope available without restriction, set its Availability to 1.0. The program selects the largest telescope with an
Availability of 1.0 as the default (startup) instrument. The Reapply Wait, Minimum Allocation, and Maximum

Allocation parameters do not apply if the Availability is 1.0.

Reapply Wait: The amount of time the student must wait to reapply if an application is not approved. The
software automatically informs the student when reapplication can be made. (1 to 255 minutes)

Minimum Allocation: The minimum number of uses that are granted if time is awarded. (The allowable values in
this field are 0-255.)

Maximum Allocation: The maximum number of uses that are granted if time is awarded. (The allowable values in
this field are 0-255.)
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Scope Factor:Thegainin light gathering power of the telescope, expressed in magnitudes (see Section VI-4 for

details, including calculation of this parameter). The zero point is determined by the “Base Magnitude” param-
eter on the Startup Parameters/Options dialog (Section V-1.1). The scope factor determines the relative speed at

which the spectra are collected, and is also used to scale the appearance of star images on the “Spectrometer”

display.

Finder Factor: The relativegainin light gathering power of the telescope finder. This parameter is used to scale

the appearance of star images orRimeler display. It is not used in calculations or for any other purpose.

Allocation of observing time is random, based onAbailability, Minimum Allocation and Maximum Allocation
parameters. (These parameters, along wRkapply Wait, do not apply to the default (0.4m) telescope.) The student is
kept informed of uses remaining as spectra are taken with the restricted telescopes.

V-2. Data Files

In order

to provide maximum adaptability, data for this exercise is read from files that can be created and/or modified

with a text editor. The various file formats used to identify and define sky fields and galaxy images, hold generated data
and results, and provide organized Help information are described in Sections V-2.1 through V-2.4 below. In addition to
conforming to the appropriate format, input data files should adhere to the general rules listed below. (In order to
interface with spreadsheet programs and the Plot program, output data and results files have a slightly different format
(comma separated values, or CSV), as described in Section V-3.1.)

1.

2.

10.

11.
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Data should be entered one record per line.

Fields within records are separated by at least one space. Do not use commas or other separators, and do not
embed spaces in numeric fields.

String fields are enclosed in single quotes (*), and the number of characters + spaces between the quotes must be
<= the maximum length of the field.

Real fields may carry a sign, and may be in fixed decimal (1.0, -2.345) or floating point (0.1234E-06, -
8.549E+18) format. Real fields will also accept integer (0, 1, -99) values.

Integer fields may carry a sign, and cannot include a decimal point or exponent.
Boolean fields may be assigned only the values O (false) and 1 (true).

The maximum allowed values for all numeric fields (in terms of both absolute value and number of digits) are
much larger than required for any reasonable values for the quantities they represent.

Values must be provided for all fields in a record, in the proper order. (Exception: all remaining empty fields on
the end of records may be omitted.) For null strings enter two single quotes ("), for null numeric fields enter 0
or 0.0.

There is no specific limit on the number of records in a file. However, these files are read into and maintained in
memory when they are used, so there is some risk of running out of heap space with a large file.

Do not include blank records in a file. Take special care to insure that there are no blank records at the begin-
ning or end of a file.

Records should not contain carriage return, line feed, or other non-alphanumeric characters. Such characters
may sometimes be inserted during file transfers by “Text Mode” protocols.
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V-2.1. Sky Fields

The sky fields for this exercise are identified in the Sky Field List File (Section V-2.1.1). Data for each sky field is

carried in a Sky Field Data File (Section V-2.1.2). In terms of format and purpose, CLEA sky field files are compatible
with all exercises that employ them. (Currently, in addition to this exercise, sky field files are Reetbalectric

Photometry of the Pleiaded he Hubble Redshift-Distance Relati@mdThe Classification of Stellar SpecfyaHow-

ever, data sets supplied with one exercise may not contain specific information required by another. For example, the sky
field data supplied with this exercise does not contain color information, and thus could not be usedPhittotlec-

tric Photometrysoftware to obtain photometric colors. (Instructors, of course, are free to add color information to the

data if they so choose.)

Sixteen star/galaxy fields are supplied with this exercise. The fields are approximately 8 degrees square (32 minutes is
Right Ascension), centered on Declination +29 degrees. The fields overlap to give continuous sky coverage from 12
Hours to 16 Hours in Right Ascension. The files contain a mixture of real and artificial data - for example, the stellar
spectral types are randomly assigned. Details of the sky field data, including information sources, field centers, magni-
tude range, algorithm for assigning spectral types, and other information, are given in Section VI-1.

When creating new sky fields for this exercise, or modifying existing fields, give consideration to the following:

1. Thefinder (wide) field of the simulated telescope is 2.5 degrees square. Users should, in general, provide fields
that are at least 5 degrees square to allow slewing from edge to edge of the field that first appears.

2. Fields should not be larger than 8-10 degrees square. (See the discussion of slewing in Section VI-3.)

3. Avoid high declinations (stay within -60 < dec < +60). The display algorithm is relatively simple, basically a
squareprojection.

4. Similarly, avoid fields that straddle the 24Hr/OHr dichotomy in right ascension. (The program will not identify a
coordinate of, for example, 23Hr 50Min RA as bemggrone at OHr 5Min, etc..)

V-2.1.1. The Sky Field List
This file provides a list of the files that contain the data for each sky field, along with the coordinates of the field centers.

It is identified in the field labele8ky Fields List on the File Name Options dialog (Section V-1.2); the default is
LSSFILES.DAT. Records in this file have the following format (see general rules under V-2):

Field Data Type Contents
File Name String[12] Name of Sky Field Data File (name + qualifier, no path).
Right Ascension Real RA of field center in decimal hours (0.0..24.0, but see

Section V-2.1).

Declination Real Dec of field center in decimal degrees (-90.0..+90.0, but see
Section V-2.1).

Field Name String[12] Field identification for selection lists.

Default Boolean One record in the file may carry a 1 (True) in this field to
identify the default sky field. All other records should
carry a 0 (False) in this field.
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The sky field list is searched for the nearest field whenever the telescope is movedSeiatberdinatesbutton) or
slewed (using the N-S-E-W buttons). See Section VI-3 for details.

V-2.1.2. Sky Field Data Files

These files contain positional and other data for each star and galaxy in a field. Each entry in the sky fields list (Section
V-2.1.1) identifies a field data file, which must be present in the working directory when the exercise is run. (Note that
these files are not identified on the Options dialog (Section V-1).) Sixteen of these files are supplied with the exercise
(Section VI-1). The user may add as many as desired (supplying corresponding entries in LSSFILES.DAT), and may also
add, delete, or modify data in the files provided. Sky Field Data File records have the following format (see general rules
under V-2):

Field Data Type Contents

Galaxy/Star ID String[15] Optional name, Messier/NGC number, HD/BD number, or other
identification. *Note 1*

Right Ascension Real RA of object in decimal hours (0.0..24.0).

Declination Real Dec of object in decimal degrees (-90.0..+90.0).

V-Magnitude Real Apparent magnitude of object.

B-V Magnitude Real Not used in this exercise.

U-B Magnitude Real Not used in this exercise.

z Real Redshift(=Delta_Lamda/Lamda) (galaxies).

(Unused) Real For future use.

(Unused) Byte For future use.

(Unused) Byte For future use.

(Unused) Byte For future use.

Object Code Byte Identifies object as a star (0), or galaxy (1).

Image Index Longint Index number of the associated “large” galaxy image bitmap in the

galaxy image list file (Section V-2.2) (galaxies). For stars, this field
contains the spectral type code (see Section IV-5).

Comment String[23] Optional additional information. (The supplied files carry the stellar

Notes: (1) Enter two single quotes (") to blank out this field.
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V-2.2. Galaxy Images

The galaxy images displayed in the sky fields are identified in the Galaxy Image List File described in Section V-2.2.1
below. The galaxy images themselves are monochromatic bitmaps, as described in Section V-2.2.2. The format of the
Galactic Spectral Features List File, which provides identifications and rest wavelengths of absorption lines appearing in
the galaxy spectra, is given in Section V-2.2.3. For information on data sources and the generation of galaxy spectra, see
Section VI-2.

V-2.2.1. Galaxy Image List File

This file provides a list of the bitmap (.BMP) files containing the galaxy images. Note that both “small” and “large”
(magnification factor 3) images must be provided for each galaxy (Section V-2.2.2).

Field Data Type Contents

Index Word Unique index number to identify the image. The assigned value is more or
less arbitrary, but “small” images must carry an index equal to the index of
the associated “large” image + 1

File Name String[12] Name of bitmap file containing the image (name + qualifier (.BMP), no
path)

Image Width Byte Width of the image, in pixels.

Image Height Byte Height of the image, in pixels.

X Center Byte X coordinate (pixels) of the center of the galactic image (not the center of
the bitmap).

Y Center Byte Y coordinate (pixels) of the center of the galactic image (not the center of
the bitmap).

V-2.2.2. Galaxy Image Bitmaps

The galaxy images are monochromatic bitmaps, extracted from image files of fields of galaxies and converted to .BMP
format. The image dimensions are not fixed, but should be made as small as possible to contain the image. A second,
reduced image of the galaxy (1/3) must be created, most image processing software will do this. (The results are gener-
ally much more satisfactory when a larger image is reduced than when a smaller one is enlarged.) The width and height
of each image (in pixels), should be recorded, along with the coordinates (X,Y in pixels) of the center of the galaxy image
(not necessarily the center of the bitmap (= width/2, height/2)). This information, along with the name of the .BMP file
and an index number, must be entered in the galaxy image list file (Section V-2.2.1). Assigned index numbers must be
unigue within the list, and the reduced images must carry an index one greater than the index of the associated larger
image.

Although the images are monochromatic, they require a 256-color graphics mode (Section 11-4) to provide sufficient
levels of gray scale. Alternate 16-color bitmaps of the galaxies are not provided. The results of reducing the images to
16 colors was found to be essentially the same as when the supplied versions are displayed in 16 colors. (The Windows
standard 16 colors include only five levels of gray scale - black, dark gray, gray, light gray, white.)
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V-2.2.3. The Galactic Spectral Features List File

This file provides identifications and rest wavelengths of absorption lines appearing in the galaxy spectra. The records
have the following format (see general rules under V-2). At the present time this file can have a maximum of five entries.

Field Data Type Contents
Wavelength Real Rest wavelength (Angstroms) of th line center.
Line ID String[15] Line name or identification.

V-3. Saving Data/Using a Spreadsheet Program

This software includes the following features to facilitate saving accumulated results, provide (optional) use of a spread-
sheet program for data reduction and analysis, and transfer data to the Plot program:

1. Accumulated results, complete or incomplete, may be saved in a file (qualifier .CSV) that is formatted for import
into commercial spreadsheet programs. This file can also be read back into the LSS program, and thus provides
a backup/restart capability, as well as a means of utilizing data generated offline. Section V-3.1 provides
information on the use and format of this file.

2. If an available spreadsheet program is identified itsgireadsheet Program Fildield on the File Name
Options dialog (see Section V-1.2), the spreadsheet may be accessed directly from the exercise. A discussion on
the use of spreadsheets in conjunction with this exercise is given in Section V-3.2.

3. Completed results may be saved to a separate file for transfer to the Plot program (see Appendix). This file
(qualifier .TXT, but also in CSV format), may be shared on a network facility to accumulate the results of all
participants. The use and format of this plotting file is described in Section V-3.3. Note particularly Section V-
3.3.1if you plan on sharing this file.

V-3.1. Saved Data

Selectingrile->Data->Save.. from the main menu causes recorded line measurements, computed velocities and other

data for measured galaxies to be written to a file (qualifier .CSV). This feature provides backup protection, allows
accumulation of data over several laboratory sessions, and is suitable for import into spreadsheet programs. Included in
this file are the program nam@l(EA_LS§ the date, time, table number and students name(s) from the login data; rest
wavelengths and identifications of the spectral lines; and data for each galaxy whose spectra has been taken and mea-
sured. The format of this file is Comma Separated Values (CSV), a text file in which commas (no spaces) separate each
field (including empty fields), and string fields are enclosed in double quotes (). When this format is read into a
spreadsheet (see V-3.2) the commas separate the data into columns. The format of the measurement records are found in
the table on the following page.
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Field Data Type Contents

Galaxy ID String Name or ID # of Galaxy.

Right Ascension Real RA in decimal hours.

Declination Real Dec in decimal degrees.

App Magnitude Real V magnitude.

Average \elocity Real Average of computed velocities for all measured lines.

Line 1 Real Measured wavelength (Angstroms) for the first spectral line.

\elocityl Real Computed velocity (km/sec) for the first spectral line.

Line n Real Measured wavelength (Angstroms) for the last spectral line.

\elocity n Real Computed velocity (km/sec) for the last spectral line.

Meas OK? Boolean Flag indicating the measurements are complete for this record.

Data OK? Boolean Flag indicating the calculated velocities have been verified for this
record.

Plotted? Boolean Flag indicating this record has been written to the plot file (Section
V-3.3).

NOTE: Boolean fields may carry only a O (False) or 1 (True).

To reload saved data in a new session, or restart an interrupted sessioRilset8ata->Load...from the main menu
before taking and measuring any new spectra.

NOTE Some CLEA users have encountered difficulties when students attempted to print from the exerciges on
shared (network) printers. These problems do not seem to originate in the CLEA software, but rather may result
from improper printer configuration (under Windows) or faulty printer driver software. Unfortunately, the typical
result is that the Windows software locks up, and the students lose data. To prevent this, the Print feature of this
software File->Data->Print) will not function unless all current data has been saved.

V-3.2. Using Spreadsheets

If the software finds an entry in tigpreadsheet Program Fildield on the File Name Options dialog (Section V-1.2),
theSpreadsheeitem on the~ile popup is enabled. SelectiRie->Spreadsheeffrom the main menu will then start the
spreadsheet software.
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For this exercise, the primary use of a spreadsheet program would seem to be computing the line and average velocities
for each record. Since spreadsheets we have seen do not provide a polar coordinate plotting capability, the completed
data must then be transferred back to the exercise itself and passed to the provided Plot program (see Section V-3.3 and
Appendix). Unfortunately, not all spreadsheets lend themselves well to this, largely because of the inability to write a file
that can be read back into the exercise software. Use of a spreadsheet as part of this exercise is entirely optional, and
other methods have been provided for computing and verifying the velocities. Please read Section V-3.2.2 before
deciding whether to employ a spreadsheet.

V-3.2.1 Loading Data

Before accessing the spreadsheet, the students must save their current data (Section V-3.1) and record the file name. The
exact technique for loading the .CSV file will depend on the spreadsheet - consult your documentation. (As examples, the
.CSV file type can be opened directly into Microsoft Excel Version 4.0 and Lotus 123 Version 5.0, while Lotus 123

Version 2.2 requireBile...Import...Numbers.) To return to the exercise, either minimize the spreadsheet program or

exit from it (after saving any modified data - see below).

V-3.2.2. Saving Spreadsheet Results

If the spreadsheet has been used to compute the velocities (including the average velocity on each record), it may be
desirable to direct the students to set the data verification flag on each record (simply change the 0 tavieasrKe
column for all completed records). If this is not done, the records will have to be verified in the exercise software before
they can be plotted. The entries in Bietted? column should be left as Os.

To save the completed spreadsheet results, select (from the spreadsheElleaeBaye As.. and select file typ€ESV.
When the file has been saved, exit the spreadshidet(Exit) and return to the exercise software. The revised data
must now be re-opened in the exerclBée¢>Data->Load..), and then passed to the plot program (Section V-3.3). If
theMeas OK flags are not set on the modified records (see above), the records will have to be velffiledxData-
>Reviewbefore they can be plotted.

The above process has been employed successfully with Microsoft Excel, Version 4.0. We presume other versions of
Excel can be used, possibly requiring some modifications to the procedure. Unfortunately, although Lotus 123 can
correctly read the data into spreadsheet cells (either select fil@eyper, in earlier versions, use the menu sequence
File->Import-> Numbers), we can find no way to generate the required comma-delimited output using 123. (We have
experimented with both the latest Windows version (5.0) and an earlier DOS version (2.2).) The “Text” output option
from version 5.0 generates a straight ASCII text output without delimiters. The only approach to using 123 appears to be
printing the results, then returning to the exercise and entering the velocity values byilearDdta->Review. We

have not determined the applicability of other spreadsheet programs.

V-3.3. Plotting Data and File Sharing

Completed results data (positions and calculated redshift velocities) must be placed in a file for transfer to the Plot
program (see Appendix). This file is identified in the options fi+dred Results FilgSection V-1.2), and may reside

on a network drive so that the contributions of all members of a group may be combined. In this Shsegthe

Results Filename must be properly set, including full path information, in all machines before students begin generating
data, and the file itself must exist (but can be empty). (Note that the defIL@TSTXT , a private (i.e., not shared) file

in the user’s working directory. This local file will be created by the exercise software if it does not exist when the
student first accesses it.) Be sure to read Section V-3.3.1 below if you plan on using a shared file for plotting.

To save results for plotting, the student selEBdes->Data->Save Results for Plot. from the main menu. All of the

student’s records which have thata OK? switch set to True (1), and tRéotted? switch set to False (0) (see Section
V-3.1) will then be appended to the plotting file, and the “Plotted?” switch on each saved record will be set to True (1).
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The plotting file is a text file in CSV format (see Section V-3.1). The format of the individual file records is as follows:

Field Data Type Contents

RA-Hrs Integer Right Ascension Hours (0..24)
RA - Min Integer RA Minutes (0..59)

RA - Sec Integer RA Seconds (0..59)

Dec - Deg Integer Declination Degrees (-89..+89)
Dec - Min Integer Dec Minutes (0..59)

Dec - Sec Real Dec Seconds (0..59)

\elocity Real Computed radial velocity (km/sec). Average of all lines measured.
Object ID String[15] Name or ID # of Galaxy.

Table # String[4] Laboratory table number
Student ID String[8] Student ID from 1st login name

V-3.3.1. Modifying CONFIG.SYS

If you intend to use a shared file to hold the group results for plotting, the following statement should appear in the
CONFIG.SYS file for all machines that are sharing the file:

INSTALL=C:\DOS\SHARE.EXE

You can use the DOS editor to check CONFIG.SYS and insert the line if it is missing. (Under DOS, be sure you are in
the root directory, then typedit config.sysat the prompt.) If you make a change to CONFIG.SYS you will have to
reboot the machine for it to take effect.

V-4. Revised CLEA Help Facility

This exercise utilizes an extension of the Help facility described iG¢neral Users’ Guide to CLEA Windows

Software (SUG). The main features of the revised facility are a Help topic selection list, with related topics indented
under group headings, and the ability to place the text for multiple Help topics in a single file. Both the selection list and
the individual Help windows now include a string search capability to assist the user. As has been the case, all files
related to the Help facility are in text format to facilitate modification or replacement by the instructor. The revised
general Help facility is described in Section 4.1. (This facility will eventually be used in all CLEA exercises, and the
material in Section 4.1 will appear in the SUG.)
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V-4.1. General Help Facility

The revised general Help facility includes several components. The Help Index File (Section V-4.1.1) identifies the
available Help topics and provides for indentation under group headings when the list is displayed for selection. The text
for each Help topic is placed in a Help Text File (Section V-4.1.2), under a topic heading that duplicates the Index File
entry. A string search capability speeds topic searches in both the selection list and the individual Help windows. Its use
is self-evident.

TheUser Helpand logouReminder features are retained as described in the SUG.
V-4.1.1. The Help Index File

The Help Index File identifies available Help topics for selection and points to the file containing the text for each topic.
Entries in the Help Index File also provide topic grouping for indentation under group headings on the selection list.

Records in the Help Index File have the following format:

Field Data Type Contents

Topic/Group Hdr String[65] Topic or group header (see V-4.1.1.1 below) to appear on the Help
selection list.

File Name String[12] Name of the file containing the text for the Help topic (name + qualifier,

no path). (See Section V-4.1.2 for the  format of this file.) If the
record’s topic field contains a group header, this field must contain
either ‘begin’ or ‘end’ (see V-4.1.1.1 below).

One Help Index File is used in this exercise, identified on the File Name Options dialog (Section V-1.2) as “Main Help
List”. The default file name is “LSSHLP.LST”.

V-4.1.1.1. Topic Grouping and Indentation

Topics on the Help selection list may be grouped and indented under group headings. To identify a group, place a record
in the Help Index File with the group header in the first field and ‘begin’ in the second. All topics below this header will

be indented two spaces on the selection list until a record with the same group header in the first field and ‘end’ in the
second is encountered. Groupings may be nested, each will indent an additional two spaces. Be sure that ‘end’ records
for all groups are provided, in the opposite order of the ‘begin’ records. For examples, see the default Help Index File
LSSHLP.LST provided with the exercise.

Group headings appear on the selection list with a “-” at each end. If the user selects a group heading from the dialog list,
he/she is instructed to select a specific subtopic under the heading.

V-4.1.2. Help Text Files

Text for the Help screens is maintained in Help Text Files (usually identified with the qualifier .HLP). If there is only one
topic in the file, it may simply contain the text for that topic (as described in the SUG). If one file contains multiple

topics, the text for each is entered under a topic header. Each topic header appears on a single line and must be identical
to the entry in the first field of the Help Index File record (Section V-4.1.1), except that the Help Text File entry is

enclosed in asterisks*("), rather than single quotes (). There are no special rules for the text entered under the

headers, except that a maximum of 72 characters per line is recommended. Users who create new Help text should check
its actual appearance in a Help window. Variable width fonts can cause unanticipated changes in appearance.
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Group headers do not have associated text, and therefore should not have related entries in a Help Text File. For an
example of a Help Text File, see LSSLAB.HLP provided with this exercise.

VI. Astronomical Data, Models and Algorithms
VI-1. Star Data

Star positions and apparent magnitudes provided with this exercise are taken from the Hubble Space Telescope Guide
Star Catalog (GSC). The field extents are given in Section VI-1.1 below. Spectral types have been artificially assigned,
as described in Section VI-1.2.

VI-1.1. Sky Fields

The data files supplied with this exercise (Section 1V-2) provide sky coverage in a region extending from 12 hours to 16
hours in right ascension and from +25 degrees to +33 degrees in declination. Each file spans 8 degrees in declination and
32 minutes in right ascension. The field centers in right ascension run from 12 Hr 8 Min to 16 Hr 8 Min in 16 minute
increments - each field overlaps its neighbor on either side by 50% (16 minutes in RA). All fields are centered on +29
degrees declination. The fields include all GSC stars brighter than m=12.0.

VI-1.2. Assigned Spectral Types

The spectral types assigned to the stars are artificially generated, and are provided solely for the purpose of authenticity -
so that a stellar spectrum will appear if the spectrometer slit is placed over a star rather than a galaxy. The types are
randomly assigned in approximate concordance with the following parameters:

Percent Type O: 1%
B: 4%

" " A: 10%
F: 15%
G: 30%
K: 30%
M: 10%

Percent Lum. I: 5%
1" 25%
V. 70%

No attempt has been made to include a luminosity or space density function in the assignment of spectral types. You may
find a 3rd magnitude star with spectral type M2V, or something equally improbable!

VI-2. Galaxies

Galaxy positions, radial velocities, and magnitudes are taken froGfAhRedshift Catalogu@uchra, 1990). (Note
that the apparent magnitudes given are B magnitudes, not V.) The selection criteria are described in VI-2.1.
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The galaxy images are taken from available collections of astronomical images on CD-ROM. They are more or less
randomly assigned, and are not actual images of the galaxies they represent. (We are in the process of gathering actual
images of the included galaxies for an updated version.) The galaxy spectra are artificially generated as described in
Section VI-2.2.

VI-2.1. Selection

Galaxies were selected from G8A Redshift Cataloguasing the following criteria:
1. Right Ascensions ranging from 12 to 15 hours
2. Declinations ranging from +27 to +32 degrees
3. Radial velocities less than 12,000 km/s
4. Objects with unknown radial velocities (listed as v=0) were eliminated.
5. Objects with unknown B magnitudes were eliminated.
6. Initially, all galaxies with B < 15.5 were included.

The list was further reduced by varying the limiting magnitude with declination, in order to make the “Great Wall” visible
without having impossibly large numbers of galaxies in the entire set. The final limiting magnitudes are as follows:

RA 12H to13H: 14.8
13H to13H 40M: 15.0
13H 40M to 16H: 154

VI-2.2. Galaxy Spectra

Galaxy spectra are generated by artificially superimposing absorption lines (Section V-2.2.3) on a 4400 K black body
spectrum. Both the absorption lines and the black body continuum are appropriately redshifted - formulae and values are
from Lang (1980). The absorption lines used are the well-known H and K lines of Call and the blended G-band, distinc-
tive features of ordinary galaxy spectra. In the future we plan to generate several templates of galaxy spectra so that the
appearance of the spectra can be linked to the morphology of the galaxy.

VI-3. Sky Field Displays and Slewing

The bitmap images used to display the sky and provide slew animation are generated as needed from the sky field data
(Section V-2.1) and galaxy images (Section V-2.2). This technique allows the greatest possible flexibility in terms of

data replacement and modification, as well as reducing disk storage requirements, but does cause the slewing process to
be not quite “seamless”. The following two effects may appear during slews:

1. Inorder to reduce runtime memory (RAM) requirements, the generated bitmap is not necessarily as large as the
data field in the file. Thus, occasional pauses will occur during slewing while a new bitmap is drawn from file
data already read. This process also occurs when the field is switchddrfdmnto Instrument, and vice
versa. On faster machines (see discussion below), this results in only hisoogin the slewing motion.

2. As aslew nears the end of the data in the current field, the software may find it necessary to load a new field file

and process the data for display, before generating a new bitmap. This entire process causes a more noticeable
pause in the slewing motion.
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The speed of a PC in performing the activities just described depends not only on the CPU speed but also on the capabili-
ties of the video hardware. Video cards identified as “accelerators” give significantly enhanced performance. The best
results will be obtained on 50 Mhz 486DX (or faster) machines with video accelerators. On a slow machine (for ex-
ample, a 25 Mhz 386SX with an ordinary VGA or SVGA card), even switchingfioder to Instrument (Item 1

above) can be a slow process. If you are running this exercise on a slow machine we recommend the following:

1. Encourage the students to G&t Coordinatesrather than slewing between fields.
2. Adjust the appropriate parameters to speed up spectrum integration (Section VI-4).

3. Warn the students that they will experience delays and tell them not to attempt to speed things up by indiscrimi-
nately clicking the mouse buttons, especially when the “Wait” cursor (hour glass) is visible.

4. Smaller fields (in terms of numbers of stars and galaxies) will load and display faster. However, the potential
gain probably does not justify the effort required to trim down or reorganize the data fields supplied with the
exercise. Instructors supplying their own data, however, might want to give some consideration to smaller fields
(but see items listed in V-2.1).

When the telescope is moved via 8et Coordinateshutton, the program searches the sky fields list to find the field

center closest to the target coordinates, and loads the corresponding sky field data file. During a slew (using the N-S-E-
W buttons), a similar search is carried out when a continuing slew in the current direction will run “off the edge” of the
loaded data. Of course, if no additional data is available the slew will eventually move off the star images and onto a
black screen. Setting the coordinates to a spot not covered by the available sky fields yields the same result.

VI-4. Integration of Spectra (Magnitudes, Telescopes and Noise)

Integration of (“taking”) spectra involves the following user-modifiable parameters:

Base Magnitude (Section V-1.1)
Sky Magnitude “
Base Photon Count
Wavelength Range
Timer Wait “

Scope Factor (Section V-1.3, also see VI-4.1 below)

In addition, we have:

Sp(Wvl) = the spectrum assigned to the object (normalized intensity as a function of wavelength (Wvl)). The
value of Sp(Wvl) lies in the range (0.0..1.0). (See Section VI-2.2.)

m = the apparent magnitude of the object
To integrate a spectrum, we begin by computing

mBase = Base Magnitude + Scope Factor(Current Scope)
We also determine the Slit Factor, which is a fraction (0.0..1.0) reflecting the accuracy with which the object is centered
in the slit. (If the Slit Factor is less than 0.05, we assume we are reading only the sky (B=0).) We compute a brightness

(B) from the magnitude equation and the Slit Factor:

B = Slit Factor * 10**((m - mBase) / -2.5)
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Similarly, a sky brightness (BSky) is computed from the Sky Magnitude parameter (mSky):

BSky = 10**((mSky - mBase) / -2.5)
We now compute an array of intensities (Int(i)) at 500 discrete points (“spectrometer channels”) covering the specified
wavelength range:

Int(i) = B * Sp(WvI(i))
(The values of Sp(Wvl) at points intermediate to the original tabulated values are determined by 3-point interpolation
(Meeus, Ch.3).) A related array of photon counts (Count(i)) is initialized to zero, as are accumulators for the total signal
counts, total sky counts, and elapsed time.

The software now initiates a timer, using the Timer Wait parameter. At each timer interrupt we perform the following
calculations for all points in the array Count(i):

XM = Base Photon Count * Int(i)
New = PoiDev(XM)

add New to Total Signal

SM = Base Photon Count * BSky
Sky = PoiDev(SM)

add Sky to Total Sky

add New + Sky to Count(i)

where PoiDev(XM) is an integer value that is a random deviate drawn from a Poisson distribution of mean Xkt (Press,
al, Ch. 7). We then calculate the signal to noise ratio (SNR) from:

SNR = _(Average Signal)

where the average is computed by dividing the Total Signal by the number of points (500). The values in array Count(i)
are normalized for plotting by dividing by MaxCount, where MaxCount is the largest current value in Count(i).

This process continues until stopped by the user, at which time the plot display changes to connect the individual points,
and the spectrum can be measured.

The effects of varying the parameters can be summarized as follows:

1. To speed up the overall rate at which the spectra integrate, lower the Base Magnitude (increase the numeric
value), increase the Base Photon Count, or both.

2. To lower the overall integration rate, raise the Base Magnitude (decrease the numeric value), decrease the Base
Photon Count, increase the Timer Wait, or any combination of the above.

3. Toincrease the effect of the sky on the spectra, raise the Sky Magnitude (decrease the numeric value), and vice
versa.

4. To vary the relative integration rates for the various telescopes, change the Scope Factors (see VI-4.1 below).

Some “tuning” of the parameters may be required to achieve satisfactory results. The effective overall integration rates
vary significantly with processor speed and video display performance.

VI-4.1 Calculating the Scope Factors

The scope factors (Section V-1.3) set the relative “gain” in light gathering power for telescopes of various sizes. Scope
factors (SF) are calculated from the magnitude equation as follows:

Let A = aperture (diameter) of telescope
B = aperture of “base” telescope
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then SF = 2.5 * log((A/B)**2)
=5 *log(A/B)
For example, in this exercise the base telescope has an aperture of 0.4 meters. Therefore, for a 1 meter telescope:

SF =5 *10g(1.0/0.4)
=5 *]og(2.5)
=2

And for a 4 meter telescope:
SF =5 *log(4.0/0.4)
=5*10g(10.0)
=5
The scope factor for the base telescope should be set to 0.0. Note that the Base Magnitude and Base Photon Count

parameters (Section V-1.1) apply to the base telescope, and establish the reference point for spectral integration rates and
other calculations (see VI-4 above for details).
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Appendix
The Plot Program

Included with this exercise is an ancillary plotting program, designed specifically to work with the data provided. The
program plots a 2-dimensional “wedge” of space from RA 12H to RA 16H. The radial component is redshift, expressed
as either radial velocity (0 - 12,000 km/sec), or Z (=V/C, 0.00 - 0.04). The plot program can be started from within the
LSS exercise (“File”->"Wedge Plot"), and can also be run independently under Windows. Input to the plot is a text file
(described in Section V-3.3) containing position and redshift information.

Read Section V-3.3 including V-3.3.1, and the second paragraph in Section Il carefully before attempting to run the plot
program. Operation is straightforward. A Help file is provided, and a little experimentation should reveal the program’s
features and capabilities. Note that many options are included to adjust the appearance of the graph, including point size,
style and color, and grids showing radial velocity, Z, both, or none. Data points can be entered manually as well as via a
file, and printouts of the data file as well as the graph itself can be generated.

A special feature is included to facilitate monitoring and displaying group progress in near-realtime. The technique is as
follows:

1. Start the plot program on a PC that has network access to the same shared plot data file (Section V-3.3) as the
students.

2. Access the fileRile->Open File).

3. SelecPlot->Autoplot->Run.

4. Enter a plot update time interval (minutes) on the dialog that appears. The program will re-read the plot data file
and update the plot at the interval entered.

5. EnterOK. The plot program will begin run in autoplot mode. The current update status is shown above the
wedge plot.

6. Students should be instructed to save their result for each galaxy in the piliefiData->Save Results for
Plot..) as soon they calculate and verify it.

Students may also use this technique as they work at their own computers. The plot can be checked periodically, then
moved off to the side or minimized while the student takes and measures additional galaxy spectra.
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